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Application Note

GE Panametrics
Ultrasonic Flow Meter
Part I

Conﬁguring the PT878 Transport
Ultrasonic Flow Meter
Overview
The PT878 TransPort Ultrasonic Flow Meter:
ä Measures liquid ﬂow in a pipe.
ä Is a non-intrusive, clamp-on ultrasonic liquid ﬂow meter for chilled
and hot water applications
ä Monitors ﬂow of ﬂuids that are homogenous, relatively clean, ﬂowing
steadily, and have no gas-phase substance present
ä Has data logging capabilities and a digital display for instantaneous
ﬂow measurements

Applications

Figure 1: Flow meter installed in
the ﬁeld.

The PT878 Flow Meter is often used for:
ä Water demand analysis, including leaks. The portable ﬂow meter can
serve as a sub-meter to measure cumulative amount of water used by
a device or a sub-system of a larger metered system.
ä Diagnosing system performance issues like variation in ﬂow and ﬂow
direction
ä Assessing load variation in hydronic heating or cooling systems.
Load is calculated using the ﬂow rate and the associated supply and
return ﬂuid temperatures. This application is beyond the scope of this
Application Note.

How it Works
This ultrasonic ﬂow meter uses a pair of transducers, with each transducer
sending and receiving coded ultrasonic signals through the ﬂuid. When the
ﬂuid is ﬂowing, signal transit time in the downstream direction (Figure 2a) is
shorter than in the upstream direction (Figure 2b). The difference between
these transit times is proportional to the ﬂow velocity. The ﬂow meter
measures this time difference and uses programmed pipe parameters to
determine ﬂow rate and direction.
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Figure 2: Theory of transit-time ﬂow measurement
A) Top view of pipe. The ultrasonic signal takes time t1 to travel downstream between
transducers.
B) The ultrasonic signal takes time t2 to travel upstream between transducers.
*The ﬂow meter uses the difference between the transit times (t2 - t1 = Δt), along with the
parameters input by the user, to calculate ﬂuid speed and volume ﬂow. If the transit time
is negative, the ﬂow is moving opposite the expected direction.
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This Application Note consists of two parts. Part I describes how to
conﬁgure the meter for ﬂow measurements and data logging using the
keypad interface. Part II describes how to install two different types of
ultrasonic ﬂow transducers: those designed for pipes of between two and
twenty-four inches in diameter and those designed for pipes of less than two
inches in diameter.

Components of the Ultrasonic Flow Meter Kit
Figure 3: The ﬂow meter kit.

1.
2.
3.
4.
5.
6.

TransPort portable ﬂow meter
Measurement rails, including one indexed rail and one un-indexed rail.
Clamping ﬁxtures and chains
Transducer cables
Ultrasonic transducers
Small pipe ultrasonic transducers (may be included instead of standard
transducers)
7. AC power adapter (not shown)
8. Ultrasonic couplant (not shown)
9. Pipe diameter tape (not shown)
10.Thickness gauge (not shown)

Powering Up and Shutting Down the Meter
1. Press the red button to power up the meter. The meter takes a few
seconds to respond.
2. To shut down the meter, press the red power button until the shutdown
options screen appears. Choose Shutdown to shut to meter off, Sleep to
put the meter in idle mode, or Cancel to resume operation.

Page 2 of 15

Using Battery Power
A new fully charged battery can provide a maximum of 8 to 10 hours of
continuous operation. Batteries must be charged 8 hours to receive the
maximum charge. The batteries recharge when the unit is plugged in to AC
power. When data logging, it is recommended that the PT878 be run on the
AC power.
When the meter is running on battery power, the battery icon in the upper
right-hand corner of the screen will show a battery level. When the meter
is running on AC power, the battery icon will either indicate that the battery
is charging or will contain a lightning-bolt symbol when the battery is fully
charged.

Deﬁning a Site
Before entering new meter conﬁguration parameters the user must create
a new site. Previously saved parameters can be reused by selecting an
existing site and using it directly or using it as a template for a new site.

Creating a New Site
1. Press the Menu button until the menu bar appears at the top of the
screen.
2. Use the arrow keys to select the Site menu and press Enter. Site
Manager will be highlighted by default (Figure 4).

Figure 4: Screen after pressing the Menu button
and selecting the Site menu.

3. Press Enter to open the Site Manager menu.
4. Press the Menu button to highlight the File menu (Figure 5) and press
Enter. New will be highlighted by default.
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Figure 5: Site Manager screen with the File menu open

5. Press Enter to open the New Site screen.
6. Press F1 (Delete) to delete the default site name and use the arrow keys
to navigate the alphanumeric table to enter a descriptive site name of
up to 8 characters. Press Enter to select each character. Press F3 (OK)
when the complete site name has been entered.
7. Choose whether or not to use the selected site as a template. (All
parameters are editable so this selection is not critical, but may save
time if there is an existing site with similar characteristics already
programmed into the meter.)
8. Press F3 (Exit) to exit the Site Manager.

Selecting an Existing Site
1. Press the Menu button until the menu bar appears at the top of the
screen.
2. Use the arrow keys to select the Site menu and press Enter. Site
Manager will be highlighted by default (Figure 4).
3. Press Enter to open the Site Manager menu (Figure 6).
4. Use the up/down arrow keys to highlight the site the user wishes to
select.

Figure 6: Site Manager screen with list of existing
sites displayed
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5. Press the Menu button to highlight the File menu and press Enter
(Figure 5).
6. Use the up/down arrow keys to highlight Open and press Enter.
7. Press F3 (Yes) or Enter to select the desired site.
8. Press F3 (Exit) to exit the Site Manager.

Conﬁguring Flow Parameters
The ﬁve main conﬁguration tabs are Transducer, Pipe, Lining, Fluid and
Path. The information entered is used by the meter to calculate the ﬂuid ﬂow
rate.
Tab
Field
Parameter
Notes
Transducer Type
Transducer type
Always clamp-on.
Transducer Transducer Transducer model Most commonly used
number
transducers:
#24 - 1/2” to 2” pipe.
#402 - 2” to 24” pipe.
#407 - 1/2” to 4” pipe.
Use the average of room
Transducer Wedge Tmp Approximate
transducer
temperature and ﬂuid
temperature*
operating temperature.
Pipe
OD, in
Pipe outside
Measure with pipe diameter
diameter*
tape.
Pipe
Wall, in
Pipe wall
Measure with PT878 thickness
thickness*
gauge.
Pipe
Material
Pipe material*
Fluid
Tracking
Activate Tracking Usually OFF. Used when the
Windows? Windows
ﬂuid is unknown.
Fluid
Fluid
Fluid type
Fluid
Sound
Sound Speed
Editable only if Other is the
Speed
selected ﬂuid.
Fluid
Temp
Fluid temperature* Editable unless Water/Glycol
is the selected ﬂuid.
Fluid
Glycol
Percent glycol*
Editable only if Water/Glycol is
the selected ﬂuid.
Path
Traverses
Number of signal Number of times the
traverses
ultrasonic signal crosses the
pipe.
Table 1: PT878 conﬁguration parameters.

Table 1 lists the parameters that must be entered into the conﬁguration tabs
listed above. To the degree possible inputs should be determined before
going into the ﬁeld, based on personal knowledge, site documentation and/or
inquiries to facility operators. Parameters marked with an asterick (*) should
be veriﬁed with ﬁeld measurements or observations.
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Transducer Tab
1. Press F1 (Transducer) to display the Transducer conﬁguration tab
(Figure 7).

Figure 7: Transducer conﬁguration tab
2. Use the down arrow key to select the transducer Type. If Clamp-on is
not selected, use horizontal arrow key to highlight Clamp-on. Press
Enter to accept the entry.
3. Use the down arrow to highlight the Transducer ﬁeld. Press Enter to
view the list of transducers. See Table 1 for a list of transducer types.
4. Use up/down arrow keys to highlight correct transducer number. Use
up/down arrows to move one row at a time and left/right arrows to page
up or down. Press Enter to accept the entry. Transducers are chosen
based on pipe diameter.
5. The next ﬁeld is labeled Wedge Tmp. The wedge temperature is the
approximate temperature of the ultrasonic transducer (“wedge”]. The
manufacturer recommends calculating this value by averaging the room
temperature and the operating temperature of the ﬂuid.
6. Use the down arrow to highlight the Wedge Tmp ﬁeld. Press Enter to
clear ﬁeld and use the numeric keys to enter the wedge temperature.
Press Enter to accept the value.
7. Press F3 (OK) to accept the changes to the Transducer tab conﬁguration
parameters and return to the main display screen.
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Pipe Tab
8. Press F1 (Transducer) to display the meter conﬁguration tabs. Use the
right arrow key to select Pipe. Press Enter to open the tab (Figure 8).

Figure 8: Pipe conﬁguration tab.

9. Press the down arrow key to highlight pipe Material ﬁeld and press
Enter to open the Material menu. Highlight the correct pipe material
from the list with the arrow keys. Press Enter to select the pipe material.
B

Pipe Thickness Measurement

A

C

10.The GE Panametrics ﬂow meter includes a gauge to measure pipe
thickness (Figure 9).
11.Use the down arrow to highlight Measure Wall with TGauge box and
press Enter. The Thickness Gauge Measure screen will appear (Figure
10).

D

Figure 9:
(A) Pipe thickness gage
(B) Calibration case
(C) Couplant gel
(D) Pipe diameter tape

Figure10: Wall Thickness measurement screen.
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12.Check the calibration of the thickness gauge using the 0.2 inch and 1.5
inch dual calibration block.
a. Connect the thickness gauge to the keyed connector jacks on top of
the meter.
b. On the Thickness Gauge Measure screen, use the right arrow key to
select the Material tab and press Enter to open the tab.
c. Use the down arrow key to highlight the Material ﬁeld and press
Enter to open the Material menu. Use the arrow keys to
select material indicated on the calbiration block and press Enter to
accept the selection.
d. Use the arrow keys to select the Display tab and press Enter to open
the tab.
e. Place a small bead of thickness gauge couplant (Couplant B) on
the 0.2 inch side of the dual calibration block and press
the calibration gauge against that side of the block. A clock icon will
appear for several seconds until the thickness
reading appears. Note the reading.
f. Repeat step e with the 1.5 inch side of the calibration block.
g. If the readings vary more than ±0.002 inch from 0.2 inches or ±0.02
inch from 1.5 inches, respectively, calibrate the thickness gauge per
step 13 below. Otherwise skip calibration.
13.If necessary, calibrate the thickness gauge using the 0.2 inch and 1.5
inch dual calibration block.
a. If it has not been done already, connect the thickness gauge to the
meter and select the material indicated on the calibration block in
the Material ﬁeld on the Material tab, as described in step
12a, b and c above.
b. Use the arrow keys to the select the Zero tab and press Enter to
open.
c. Use the arrow keys to highlight Dual Calibration and press Enter to
select.
d. Use the down arrow key to highlight the Block 1 Length ﬁeld. Press
Enter to edit the ﬁeld, enter 0.2 and press Enter again.
e. Use the right arrow key to highlight the box containing the word
“Calibrate” located to the right of the Block 1 Length ﬁeld. Press
Enter. The box will now read “Ready”.
f. Place a small bead of thickness gauge couplant (Couplant B) on
the 0.2 inch side of the dual calibration block and press the
calibration gauge against that side of the block. Press Enter.
A clock icon will appear for several seconds and then the box
will again read “Calibrate”.
g. Repeat steps f, g and h for the 1.5 inch side of the dual calibration
block using the ﬁelds associated with Block 2 Length. The
Set button will appear once the user is done calibrating with the 1.5
side of the dual calibration block.
h. Once the Set button appears, press Enter. Press F3 to go back to
the Pipe tab.
i. Check that calibration has been successful. With Measure Wall
with TGauge highlighted, press Enter to return to the Thickness
Gauge Measure screen. Evaluate the results as indicated in
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14.Before measuring pipe thickness, select the correct pipe material.
From the Thickness Gauge Measure screen, use the right arrow key
to select the Material tab and press Enter. Use the down arrow key to
highlight the Material ﬁeld and press Enter to open the Material menu.
Use the arrow keys to select the appropriate pipe material and press
Enter to accept the selection.
15.Prepare the pipe. The user will take thickness measurements on the
section of pipe where the clamping ﬁxture, rails and transducers will
be installed. On this section of pipe, cut back the insulation, remove
any loose paint, and clean the pipe and sand off any corrosion or rough
spots. If the pipe is extremely rough the thickness measurements may
not be accurate and, once the transducers are installed, the ultrasonic
signal will be scattered by the rough surface and will not be received by
the ﬂow meter, preventing ﬂow measurement.
16.Calculate average pipe thickness. The thickness value will be used to
determine both the trajectory of the ultrasonic signal and the crosssectional area of the pipe. For the latter, an average pipe thickness
should be calculated. Take at least four thickness measurements at
even intervals around the diameter of the pipe in between where the
transducers will be installed.
17.Apply thickness gauge couplant (Couplant B) at an appropriate spot on
the pipe where the user will be making the thickness measurement. The
smoother the pipe surface the thinner the couplant should be applied.
The line on the face of the transducer should be positioned so that it is
perpendicular to the liquid ﬂow in the pipe (Figure 11).
Figure 11: Proper alignment of
thickness transducer on cylindrical
run of pipe.

Figure 12: Pipe-diameter tape
being used to measure a 3.5 in.
diameter pipe.

18.Hold the pipe thickness transducer ﬂat against the pipe surface. Note
the measured pipe wall thickness value displayed on the meter.
19.Repeat at three or more other locations evenly spaced around the pipe
diameter. Calculate the average thickness.
20. Once done with thickness measurements, press F3 (OK) to return to
the Pipe menu. Use the arrow keys to highlight the Wall, in ﬁeld. Press
Enter to clear the ﬁeld and enter the average pipe thickness with the
numeric keys. Press Enter to accept the value.
21.Measure the outside diameter of the pipe with the pipe diameter
measuring tape included with the pipe thickness gauge kit, as shown
in Figure 12. Use the arrow keys to toggle to the OD, in ﬁeld and press
Enter to clear the ﬁeld. Enter the pipe outside diameter in inches with
the numeric keys and press Enter to accept the value.
22.Press F3 (OK) to accept the changes to the Pipe tab conﬁguration
parameters and return to the main display screen.
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Lining Tab
23. Press F1 (Transducer) to display the meter conﬁguration tabs. Use the
arrow keys to select the Lining tab and press Enter.
24. If the pipe has no anti-corrosion lining, check that the lining Material ﬁeld
is set to None, the default value.
25. If the pipe has an anti-corrosion lining, use the arrow keys to highlight the
Material ﬁeld and press Enter to open the lining Material menu. Use the
up/down arrow keys to highlight the lining material. Press Enter to select.
26. Press F3 (OK) to accept the default setting or the changes to the Lining tab.

Fluid Tab
The options available on the Fluid tab will vary depending on whether the
meter’s Energy Options are enabled or disabled.

Selecting Energy Options
This section will address Energy Options as they relate to conﬁguration of the
Fluid tab. Though it is beyond the scope of this Application Note, the Energy
Options screen can also be used to conﬁgure temperature inputs required for
the meter to calculate heating or cooling loads. See the PT878 Operation &
Installation Guide for details.
If Energy Options are disabled, the Fluid ﬁeld on the Fluid tab will display a
pre-deﬁned list of ﬂuids, including Water, and an Other ﬂuid option. If Energy
Options are enabled, the Fluid ﬁeld will display a list including Other, Water,
and Water/Glycol, with no additional pre-deﬁned ﬂuids available.
As a result, if the working ﬂuid is water or a custom ﬂuid not deﬁned in the
PT878’s ﬂuid list, Energy Options may be either enabled or disabled. If the
working ﬂuid is a water-and-glycol mix, enabling Energy Options will simplify
the conﬁguration of ﬂuid parameters because the ﬂuid will not have to be
entered as a custom ﬂuid. In order to select a ﬂuid other than water from the
PT878’s pre-deﬁned ﬂuid list, Energy Options must be disabled.
a. To conﬁgure Energy Options, ﬁrst press the Menu button until the menu list
appears at the top of the screen.
b. Use the arrow keys to select the Program menu and press Enter. Use the
down arrow key to select Energy (Figure 13). Press Enter again to open
the Energy Options screen (Figure 14).
Figure 13: Select Energy from the Program
menu to open the Energy Options screen.
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Figure 14: Energy Options screen.

c. Use the arrow keys to select Enable or Disable. Press Enter and then
F3 (OK) to accept the selection and return to the main screen. Note that
when Energy Options are enabled a ﬂame icon appears in the System
Tray near the bottom of the screen.
27.Once the appropriate Energy Options are selected, press F1
(Transducer) to display the meter conﬁguration tabs. Use the arrow
keys to highlight the Fluid tab. Press Enter to open the tab (Figure 15).

Figure 15: Fluid conﬁguration tab. The

28.Leave the Tracking Windows option set to “No”. The tracking window
option is used when ﬂuid is unknown and is beyond the scope of this
Application Note.
29.Use the arrow keys to highlight the Fluid ﬁeld and press Enter to open
ﬂow meter’s Fluid list. Select either a pre-deﬁned ﬂuid from the Fluid
list, or, if the ﬂuid is not on the list, select Other. Press Enter to accept
the selection.
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30.If Other was selected as the ﬂuid type the user will need to deﬁne
the ﬂuid’s behavior by entering a sound speed into the Sound Speed
ﬁeld. Fluid sound speeds can be found in the Installation Reference
manual titled Sound Speed and Pipe Size Data (included with this
ﬂow meter) or in an alternative reference source. Use the arrow keys
to toggle to the Sound Speed ﬁeld. Press Enter to clear the ﬁeld and
enter the speed of sound for the appropriate ﬂuid with the numeric
keys. Press Enter to accept the selection.
31.If a pre-deﬁned ﬂuid or Other has been chosen from the Fluid list,
use the arrow keys to highlight the ﬂuid Temperature ﬁeld.
32.If a water/glycol mix has been selected as the working ﬂuid, the
Glycol ﬁeld will be editable rather than the ﬂuid Temperature ﬁeld.
Use the arrow keys to highlight the Glycol percent ﬁeld.
33.Once the editable ﬁeld has been selected (either Temperature or
Glycol), press Enter to clear the ﬁeld and use the numeric keys to
enter appropriate value. Press Enter to accept the new value.
34.Press F3 (OK) to accept the changes to the Fluid tab conﬁguration
parameters and return to the main display screen.

Path Tab
35.Press F1 (Transducer) to display the meter conﬁguration tabs. Use
the arrow keys to highlight the Path tab and press Enter (Figure 16).
The Traverses ﬁeld is the only editable ﬁeld on the Path tab. The
transducer spacing shown in the Spacing ﬁeld is calculated based
on all of the other user-input parameters and is required for correct
installation of the ﬂow transducers.

Figure 16: Path conﬁguration tab.

36.The value in the Traverses ﬁeld indicates the number of times the
ultrasonic signal crosses through the ﬂuid from one side of the pipe
to the other in transit between the two ultrasonic ﬂow transducers.
See Figure17. To input this value, use the arrow keys to highlight
the Traverses ﬁeld. Press Enter. Use the arrow keys to choose 2
traverses, unless the user has a reason to use a different transducer
conﬁguration. Press Enter to select.
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Figure 17: Ultrasonic signal traverses
Top views of pipe. The number of traverses indicates the number of times the
ultrasonic signal crosses the pipe. a) One (1) traverse. b) Two (2) traverses
c) Three (3) traverses c) Four (4) traverses. It is most common to use two (2)
traverses. Additional traverses weaken the signal but provide a more accurate
ﬂow measurement.

37.The value in the Spacing ﬁeld is the Transducer Spacing calculated by
the meter after all of the measurement parameters have been entered.
Press F3 (OK). If prompted, press F3 (OK) again to acknowledge the
Warning message that indicates that the transducer spacing has
changed. Make note of the Transducer Spacing value.
38.Press F3 (Save Now). Press F3 (Yes) to choose the site name that is
displayed in the Save Site screen.

Changing Display Values and Units
To change the display units between Metric and English units do the
following:
1. Press the Menu button until the menu bar appears at the top of the
screen.
2. Use the arrow keys to select the Meter menu. Press Enter.
3. Use the arrow keys to highlight Units. Press Enter.
4. Use the arrow keys to select Metric or English units. Press F3 (OK) to
accept the selection.
To display different measured and calculated values and change display
units in any of the PT878 output windows, do the following:
1. Press the Menu button until the date and time are shown at the top of
the screen.
2. Press the down arrow key until a triangle appears on the left edge of
the title bar in the appropriate output window. Press Enter.
3. Use the arrow keys to highlight Measurement and press Enter.
4. Use the up and down arrow keys to highlight the desired display
parameter.
5. Press the SEL button to select the parameter and use the up and down
arrow keys to highlight the desired units. Press F3 (OK) to accept the
selection.
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Conﬁguring Flow Meter for Data Logging
1. When logging, it is recommended that the PT878 be run on AC power.
Note that a new, fully-charged battery can provide a maximum of 8 to
10 hours of continuous operation.
2. Press the Menu button until the menu bar appears at the top of the
screen.
3. Use the arrow keys to highlight Logging tab, New Log and press Enter.
4. Press F1 (Delete) to delete the default log name and use the arrow
keys to enter a descriptive log name, pressing Enter after each letter
or number is highlighted. Press F3 (OK) when the complete log name
has been entered. Two logging conﬁguration tabs will be displayed:
General and Measurements.

General Tab
5. Use the arrow keys to toggle between the Format options and press
Enter to select. Choose Linear to program the meter to stop logging
when the memory is full. The Linear option is the more appropriate
one for most logging applications. Choose Circular to program the
meter to continue to log when the memory is full by overwriting the
earliest data records with the newest data.
6. Use the arrow keys to select log Type. Choose Standard and press
Enter.
7. Enter the Start and End dates and times. Toggle to the correct ﬁeld
to highlight. Press Enter and then edit the values in the ﬁeld with the
arrow keys. Press Enter after each ﬁeld has been edited and use the
arrow keys to toggle to the next ﬁeld.
8. Use the arrow keys to toggle to the Logging Interval ﬁeld. Press Enter
to activate the text box and use the numeric keys to enter the number
of seconds in the logging interval.

Measurements Tab
9. Use the arrow keys to select the Measurements tab and press Enter to
open.
10.Use the arrow keys to highlight one of the variable boxes on the
Measurements table. The box will initially read “NO UNITS”. Press
Enter to open the Measurements variable list.
11.Use arrow keys to indicate the desired variable. Press the SEL button
to conﬁrm the selection. The prompt automatically moves to the list of
units.
12.Use the arrow keys to highlight the desired units. Press the SEL
button to select the units and then press F3 (OK) to conﬁrm the
selection. Once selected, the measurement variable and units will
appear in the Measurements table.
13.Repeat for up to 12 different parameters.
14.Press F3 (Activate) to Activate the Log.
15.Press F3 (Exit) to exit the log menu and return to the main ﬂow screen.
Press F3 (Save Now) to save changes.
16.Note that log ﬁles cannot be edited once created. If a log ﬁle must be
changed, creat a new log ﬁlethat includes the desired changes.
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17.Note that if a log has been created and has started logging (Running),
a pencil with horizontal lines on its left side will appear in the System
Tray at the bottom of the screen. If a log has been created but has not
started logging (Pending), a pencil without horizontal lines will appear
in the System Tray. If all logging is complete or no logs have been
created (no logs are Pending or Running), no pencil will appear in the
System Tray.

Downloading the Data Log from the meter to the PC
1. Load the PanaLogViwer software from the CD included with the ﬂow
meter. This software is compatible with Windows operating systems
only.
2. Load the IR adaptor drivers from the mini-CD provided with the
adaptor. Then connect the IR Adaptor to an available USB port.
3. Once the IR adaptor is working, place the IR port on the adaptor
directly in front of the IR port on the meter.
4. On the PT878 console, press the Menu button and use the arrow keys
to highlight the Logging menu heading. Press Enter.
5. Highlight Log Manager and press Enter. Use the arrow keys to
highlight the correct log to download.
6. Press the Menu button to highlight the File menu heading and press
Enter. Use the arrow keys to highlight Transfer and press Enter.
7. A message will be displayed on the computer screen indicating that
a ﬁle is being sent through a wireless link. Click yes to accept the ﬁle
transfer. It may take several minutes for the ﬁle to transfer to the
user’s computer. The transfer is proceeding correctly unless an error
message is displayed.
8. Open the PanaLogViewer software. Choose File; Open. Select the .LOG
ﬁle and click the OPEN button.
9. Click the EXPORT button to convert the .LOG ﬁle to a .CSV ﬁle that can
be opened and viewed in EXCEL. (Note that exporting directly to an
XLS spreadsheet data format is unreliable and may cause the Panalog
application to terminate without warning. However, this does not
damage the data ﬁle.)
10.When ﬁnished, turn the meter power off.
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